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File Manager Jr. 1.3


For Version 6.0 of Microsoft® Word for Windows™





File Manager Jr. comes in a smaller package than the Windows File Manager but performs many of the same functions.  Only faster.


Using File Manager Jr., you can quickly move, copy, delete and rename files without having to switch to the Windows File Manager.  You can also open existing files, delete all bak files in a specified directory and print documents without having to open them.  You can create, rename and delete directories.  And you can recover deleted files (if you have MS-DOS 6 or 6.2).


Version 1.3 of File Manager Jr. can be used to work with files in the main Word directory and in Word subdirectories and sub-subdirectories.





Conventions used in this guide


Word subdirectories created for document storage are referred to as “document directories.”  Examples: c:\winword\personal and c:\winword\reports would be document directories.


Directories created as branches of document directories are referred to as “document subdirectories.”  Examples: c:\winword\personal\notes and c:\winword\reports\sales would be document subdirectories.


Word’s home directory is called the “main Word directory” or “main directory.”


Command buttons are sometimes referred to simply as “commands.”


Names of File Manager Jr. commands appear in boldface.  Filenames and directory names appear in small capitals.  Words that the user is to type appear in small bold capitals.  Section titles are boldfaced when cited in the text.





Running the program


To make it easy to start File Manager Jr., you should assign the program to a shortcut key or toolbar button.  (If you need help, see the step-by-step directions on page 14.)


When the program starts, you see the main menu.  One column of commands appears on the left and another on the right.  An open panel appears at the center.   This panel is called the Directory box.
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If you select a command in the left-hand column, a list of directories appears in the Directory box (as illustrated below).  You then choose the directory in which you want to carry out the command you have selected.
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Commands in the right-hand column are enclosed in a free-standing box and operate independently, bypassing the Directory box.  If you choose a command button on the right, the specified command starts running immediately.


Using File Manager Jr. commands is simple.  Examples:





Mouse   To open a file in a document directory called c:\winword\reports, first click the Open button in the left-hand column.  A list of directories appears in the Directory box.  Double-click the name of the reports directory.  A file list appears.  Double-click the name of the file you want to open.


	


Keyboard   To delete a file in a document directory called c:\winword\memos, first select the Delete button by pressing the D key.  A list of directories appears in the Directory box.  Highlight the name of the memos directory and press Enter.  A file list appears.  Highlight the name of the file you want to delete.  Press Enter.





Additional illustrations:





Mouse   It’s important to distinguish between double-clicking and single-clicking names in the Directory box.  If you select a command in the left-hand column and then double-click a name in the Directory box, the selected command is set in motion at once.  Example: If you select the Open button and then double-click the name of the personal directory, the program immediately displays a list of the files in that directory.


If you want to access a file stored in a document subdirectory, click a directory name once instead of twice and then click the Show Subdirectories button.  Clicking Show Subdirectories changes the display at the center of the main menu.  A Subdirectory box appears in place of the Directory box so that you can choose a subdirectory name.  Example:


To delete a file in the document subdirectory c:\winword\reports\sales, first select the Delete button.  Then single-click the name reports in the Directory box and choose the Show Subdirectories button.  A Subdirectory box appears, displaying the names of all reports subdirectories.  Choose the name of the sales subdirectory.





Keyboard   To access a file stored in a document directory, select a command in the left column, highlight a name in the Directory box and press Enter.  The selected command is set in motion at once, just as if you had double-clicked the directory name.


To access a file stored in a document subdirectory, select a command, highlight a directory name and then choose the Show Subdirectories button.  You can choose Show Subdirectories by pressing Tab and then Enter, or Tab and then the spacebar, or Tab and then the S key.  When a Subdirectory box appears, select a subdirectory name and press Enter.





General   When you select a command button in the left-hand column, some unexpected names may appear in the Directory box.  Besides displaying the names of your document directories, the box displays names of directories preassigned by the developers of Word for Windows.  If you installed the full Word program, you’ll see the names of seven preassigned directories, including clipart, setup,  template and wordcbt.  File Manager Jr. treats the names of preassigned directories as reserved names.  If a directory has a reserved name, your can’t use File Manager Jr. commands to work with files in that directory.  Example: You can’t use the Delete command to erase a file in the template directory.


Whenever you select a command in the left-hand column, the program assembles a list of your Word directories and displays the list in the Directory box.  If you have a great many document directories, it may take the program a moment or two to assemble and display the list.


If you select a command in the left-hand column and discover that you picked the wrong command, you can reselect.  Example: If you intend to select Delete but instead select Undelete, just click Delete.  Or choose the Home button to start over.  To choose Home using the keyboard, press Tab and then the H key.


To run one of the commands in the column on the right side of the main menu, simply click a button or press a letter key.  Example: To run the Back Up command, click the Back Up button or press the B key.  If you select a button in the left-hand column when you meant to choose one on the right, just click the button you intended to choose initially.  Or choose the Home button to start over.


To perform an operation on a file in drive A or drive B, select a command in the left-hand column and then choose a drive button by clicking it or by pressing Tab and then a letter key (the V key for drive A, the E key for drive B).


A button labeled drive x appears at the right of the drive B button.  The function of drive x is explained later.   





Note    For brevity, most step-by-step examples found later in this guide omit keyboard directions.  Such directions appear only when procedures used to perform a keyboard operation have not been covered by earlier examples.








File Manager Jr. commands


Open   The command opens a previously saved file.  Examples:


To open a file stored in a document directory called c:\winword\reports, first select the Open button.  Then double-click the name reports in the Directory box.   An Open File dialog box appears.  Choose the name of a file to open.


To open a file in a document subdirectory called c:\winword\reports\sales, select the Open button, single-click the name of the reports directory and then choose the Show Subdirectories button.  A list of subdirectories appears.  Double-click sales.  In the next box, choose the name of a file to open.


Without opening any documents, you can use the Open command to get information about files.  Example: To see which files are stored in a directory called c:\winword\personal, first select the Open button.  Then double-click the name personal in the Directory box.  After checking the file list, click Cancel or press the Esc key to close the Open File box.





Note    A Back button appears in the Open File box and in many other File Manager Jr. dialog boxes.  You can use the Back button to return quickly to the main menu if you open a dialog box by mistake.  Just click the button or press Tab and then the B key.  To close a box without redisplaying the main menu, click Cancel or press Esc.  (If no list of files or directories appears in a box with a Back button, you can return to the main menu by pressing B without first pressing Tab.  But the Tab-B combination will also work.)





Move   The command transfers a file from one directory to another.  It will also move a file to or from a disk in a floppy drive.  Procedure: 


To move a file from a document directory, first select the Move button.  In the Directory box, double-click the name of the directory containing the file to be moved.  A file list appears.  Choose a filename.


To move a file from a document subdirectory, first select the Move button.  In the Directory box, click a directory name once.   Then click the Show Subdirectories button.  A Subdirectory box replaces the Directory box.  Choose a subdirectory.  Then choose a filename.


To move a file from drive A or drive B, select Move and click the appropriate drive button.  Then choose a filename.


When the file to be moved has been chosen, the program displays a list box labeled Destination.  To move a file to a document directory called reports, double-click the name reports in the Destination box.


To move a file to a document subdirectory, single-click a directory name in the Destination box and then choose the Show Subdirectories button.  The Destination box is replaced by a Destination Subdirectory box.  Choose a subdirectory.


To move a file to drive A or drive B, click the appropriate drive button in the lower part of the Destination box. 





Copy   The command creates a duplicate of a file and sends the duplicate to a destination of your choice, leaving the original copy of the file in place.  The command works much like Move.








Delete   The command erases a file.  It is structurally similar to the Open command.  After the command is set in motion, a file list appears.  Choose a filename.





Undelete   The command recovers erased files, using the Undelete for Windows program in MS-DOS 6.0 or 6.2.  Select the Undelete button and then choose the name of a directory or subdirectory just as you would if you were using one of the commands described earlier.


When the Microsoft Undelete window appears, select one or more filenames and click the Undelete icon.  To close the window, choose Exit on the File menu.


To tell DOS what level of file protection you want to use, choose the Undelete icon from the Microsoft Tools group in the Windows Program Manager.  Or start the Windows File Manager and choose Undelete on the File menu.





Kill BAKs   The command erases all bak files in a specified directory.  To delete bak files stored in a document directory, first select the Kill BAKs button and then double-click a directory name.  To delete bak files stored in a document subdirectory, select the Kill BAKs button, click a directory name once and then choose the Show Subdirectories button.  A Subdirectory box replaces the Directory box.  Choose a subdirectory name.


The command does not delete bak files on floppy disks.  (When you select the Kill BAKs button, the drive a and drive b buttons are dimmed and inaccessible.)





Rename   The command changes the name of a file.  First select the Rename button.  Then choose the name of a document directory or subdirectory just as you would if you were using one of the commands described earlier.


When asked to enter a new name for a document, type a filename only.  Do not type a directory name or subdirectory name ahead of the filename.  Example: Don’t type c:\winword\memos\baker.doc.  Just type baker.doc.





Print File   The command lets you print Word documents without opening them.  Example: You’re working on a file in the personal directory and need a printout of a file stored in the reports directory.  Procedure: Select the Print File button and then double-click the name reports in the Directory box.  A list of the files in the reports directory appears so that you can choose the file to be printed.


You can also use the command to print a file stored in a document subdirectory.  To view a subdirectory file list, proceed just as you would if you were executing one of the commands described earlier.


After choosing a file to print, you’re asked whether you want to print one copy of the complete file.  If you answer Yes, printing starts.  If you answer No, a new box appears so that you can tell Word to print multiple copies or only certain pages.   





Save New   The command is used to specify where a file will be stored when saved for the first time.  Example: If you want to store a new file in a document directory called reports, select the Save New button and then double-click the name reports in the Directory box.


To store a new file in a document subdirectory, first select the Save New button.  Then click a directory name once and choose the Show Subdirectories button.


When asked to enter a name for a new document, type a filename only.  Do not type a directory name or subdirectory name ahead of the filename.  Example:  If you’re naming a new file dock.doc and storing it in c:\winword\memos, don’t type c:\winword\memos\dock.doc.  Just type dock.doc.


The command cannot be used to store a new file on a floppy disk.  (When you select Save New, the drive a and drive b buttons are dimmed and inaccessible.) 





Get Stats   The command displays statistical information about files in a specified directory.  Example: You’re working on a file in the personal directory.  The file dock.doc is stored in the memos directory.  You want to know the size of dock.doc and the date it was last saved.  Procedure:


Select the Get Stats button.  Double-click the name memos in the Directory box.  A Find File box appears, listing the files in the memos directory.  Highlight the filename dock.doc to display statistical information about that file.  If you want information about a second file, highlight another filename.  When finished, press Esc to close the Find File box.


You can also get statistical information about files stored in a document subdirectory.  Just select the Get Stats button and then choose a subdirectory as you would if you were using one of the commands described earlier.





Back Up   The command sends a copy of the active document to a backup disk in the A drive.  Any previous backup copy is overwritten.


If you want to use the B drive for backups instead of the A drive, choose the Setup button on the right side of the main menu.  Then choose the Change Backup Drive button.


Note that Back Up is the first command in the right-hand column on the main menu.  Like other commands in that column, it is independent of the Directory box.  To run the command, simply click the Back Up button or press the B key.


Print Selection   The command prints a selected block of text.  First highlight the text you want to print.  Then choose the Print Selection button.  (The selected block of text must be at least two characters long.)





Find File   The command helps you locate a file when you can’t remember where you stored it or can’t remember its name.


When you start the command, you’re asked whether you want to search for a filename or for text.  If you know the name of the file you’re looking for, choose the Filename button and type a name in the next box.  If the file is found, its directory is identified.  If you don’t know the name of the file you’re looking for, choose the Text button.  When asked to enter text, type a phrase that is likely to be found only in the file you’re looking for.  Important: Enclose the phrase in quotation marks.  And note: Finding text takes time.





File Info   The command displays a word count, a page count and other statistical information about the active document.





Directory Mgr.   The command is used to create, rename and delete directories.  For additional information, see More about Directory Mgr. later in this guide.





Address List   The command places an inside address in a business letter.  The address is copied from a file in which you have stored names and addresses.  The command is also used to print envelopes and to edit, browse and sort the address file.  For additional information, see More about Address List later in this guide.





Junk Closet   The command is used to store text temporarily in a holding file or to retrieve text from the holding file.  For additional information, see More about Junk Closet later in this guide.





Quit Word   The command closes any open files and quits Word for Windows.  Use the command when you want to make a quick exit.  If any open documents have been changed since they were last saved, the changes are preserved.





Note    If you have entered text in a new document but have not yet named the document, you’ll be asked to supply a name before quitting Word.


Drive X:  A rest home for old files


If you have two hard drives, you can use your secondary hard drive for storage of old files—files you don’t want to delete but would like to move out of your regular document directories to reduce clutter.  The drive x button (in the lower part of the main menu) makes it easy to move old files to a secondary drive.


The letter X in drive x can stand for any working hard drive.  If you have a C drive and a D drive, for example, you can tell File Manager Jr. to recognize the D drive as drive x.  You can then conserve space on C by storing old files on D.


First you need to assign a drive and directory to the drive x button.  To begin, choose the Setup button on the right side of the main menu.  In the Setup box, choose the Drive X Setup button.  In the next box, type a drive identifier and a directory name.  Example: d:\oldfiles.  If the directory you specify doesn’t exist, File Manager Jr. can create it.


After assigning a drive and directory to the drive x button, you can use the Move command to transfer old documents to drive x.  Example: If you want to transfer an old file from c:\winword\personal, select the Move button and then double-click the name personal in the Directory box.  A file list appears.  Choose a filename.  When asked to specify a destination for the file, click the drive x button.





Note    You can open, move, copy, delete, rename and print old documents stored in drive x.  Example: If you want to open an old document, select the Open button and then click the drive x button.





More about Directory Mgr.


To create a directory, first choose the Directory Mgr. button.  Then choose the Create button and indicate whether you want to create a document directory or a document subdirectory.  Enter a name in the next box.  If you’re creating a document directory, do not type a path ahead of the name.  Example: Don’t type c:\winword\journal.  Just type journal.  If you’re creating a document subdirectory, the name of the parent directory will be entered for you.  Just add the name of the new subdirectory.


To rename a directory, first close any open document windows in that directory.  Then run Directory Mgr. and choose the Rename button.  The form used to enter a new name for a directory or subdirectory is the same as the form used to enter a name when you create a directory or subdirectory.  (See the previous paragraph.)


To delete a directory, first close any open files in that directory.  Then run Directory Mgr. and choose the Delete button.  Follow the onscreen directions.  If the directory you want to erase is not empty, File Manager Jr. displays a warning.





Note    MS-DOS won’t let you use certain characters in directory names.  File Manager Jr. disallows the following additional characters: the percent sign, the parentheses, the caret (^),  the ampersand (&), the braces ( { } ) and the swung  dash (~).





More about Address List


When you choose the Address List button, you see a dialog box with four command buttons.  The first command is Copy.  It places an address block in a business letter, saving you the trouble of typing an inside address.  The block is copied from a file in which you can store frequently used addresses.  The file is called namelist.fmj.  It was placed in the main Word directory when you installed File Manager Jr.


To copy an address block, first place the insertion point anywhere on the top line of the body of your letter.  Then run Address List and choose the Copy button. You’ll be asked to type a name.  If you want to copy the address of an individual, type a surname. Example: If you’re writing to Horatio D. Blunt, type blunt.  If you want to copy a business address in which no individual is named, type the first word in the name of the business.  Example: If you’re writing to the law firm of Hussler & Hassler, type hussler.  (You may be able to save keystrokes by typing only the first four or five letters of a long name.)


The style you use for letters does not have to match the style used to set up your address list in the namelist.fmj file.  If the styles are different, address blocks imported with the Copy command are converted to your letter style.


The second command in the Address List dialog box is Print Envelope.  If you have a business letter onscreen, you can use the Envelopes and Labels command on the Tools menu to copy the delivery address from the letter to an envelope.  Sometimes, however, you may be unable to use that command because you’re mailing material without a cover letter.  Solution: If the recipient’s name is in your address file, you can still print an envelope quickly.  Just choose Print Envelope in the Address List dialog box and follow the onscreen directions.  


By default, the Print Envelope command uses the Courier typeface and does not print a return address on your envelopes.  You can override these defaults.  Procedure:  On the main menu, choose the Setup button.  In the Setup box, choose Envelope Setup.  First select a font and a point size.  When asked whether you want a return address printed, choose the Yes or No button.  If you choose Yes, Word will use whatever address it finds in your Mailing Address box.  To see what’s in that box, choose Options on the Tools menu and click the User Info tab.


The third command in the Address List dialog box is Edit/Browse.  Use it when you want to open the address file so that you can add addresses, delete addresses or just look around.


When you choose the Edit/Browse button, you’re asked where you want to start in the address file.  Choose a letter.  The command searches for the first listing under that letter.


If you’re entering a new address listing, follow this form:





Blunt*Horatio D.


Blunt Instruments Limited


12345 Sixth Street


San Lardo, California 90000-0000


Mr. Blunt


408-000-0000





The person’s last name comes first.  Next comes an asterisk.  No space is left before or after the asterisk.  Do not use an asterisk anywhere else in a listing.  


When a listing is copied to a letter, File Manager Jr. rearranges the first line and removes the asterisk.  Like this:





Horatio D. Blunt


Blunt Instruments Limited


12345 Sixth Street


San Lardo, California 90000-0000





Dear Mr. Blunt:








The “Mr. Blunt” in the salutation is copied from the next-to-last line of the Horatio Blunt address listing.  If that line were changed from “Mr. Blunt” to “Horatio,” the address would be copied with a “Dear Horatio:” salutation.


A salutation name is entered on the next-to-last line of each listing.  The name must not be omitted.


The last line of each listing is reserved for a telephone number and remarks.  Example:





212-000-0000. Stanford grad. Birthday: 6/15. Wife: Gloria.








It’s OK to use more than one line for remarks, but the remarks must be confined to a single paragraph.  Do not press Enter between remarks.


If you don’t have a phone number for someone on your list and no remarks are needed, type several zeros on the phone-number line.  Do not omit the line.


When an address listing begins with a name that includes an abbreviation such as “M.D.,” “Esq.” or “Jr.,” the abbreviation is treated as an extension of the last name and is entered before the asterisk.   


Correct form:  Flapdirdle, M.D.*Clyde C.


Incorrect form:  Flapdirdle*Clyde C., M.D.


If a last name consists of two or more words, the asterisk goes after the last of those words.  Example:





Van der Flatt*Vanessa C.


Chief Executive Officer


Van der Flatt Tire Corporation


700 Avenue of the Aleutians


New York, New York 10000-0000


Ms. Van der Flatt


212-000-0000








If you use a courtesy title such as “Ms.” or “Mr.” on the first line of a listing, place the title just after the asterisk.  Example:





Van der Flatt*Ms. Vanessa C.








When a listing begins with the name of a firm rather than with the name of an individual, follow this form:





Hussler & Hassler*


Attorneys at Law


Jarndyce Center


123 Fourth Street


Hacksaw, Texas 75000-0000


Counselors


509-000-0000








Notice that the asterisk appears at the end of the first line of the listing, after the name of the law firm.  (The full name of the firm is treated as a surname.)


A listing may run five to seven lines.  Here is an example of a five-line listing:





Cartwright*Mr. Crispin C.


1234 Fifth Street


Bounding, Maine 04000-0000


Mr. Cartwright


207-000-0000








Important: Leave one or two blank lines below each listing.


After entering one or more new listings, choose Close on the File menu and answer Yes when asked whether to save changes.  Follow the same procedure after deleting one or more listings.





Note    Eleven blank lines have been placed at the top of the address file.  They should not be removed.  Several fictitious address listings have been entered in the file for illustrative purposes.  They may be deleted.





The Edit/Browse command can also be used to look up information in the address file.  Example: If you need the telephone number of Horatio Blunt, run Address List and choose the Edit/Browse button.  Then choose B.  The insertion point appears before the first listing under that letter.  After finding Blunt’s phone number, quit the address file by choosing Close on the File menu.


The last command in the Address List dialog box is Sort.  It alphabetizes address listings.  When you add listings using the Edit/Browse command, you don’t need to jump around in the address file to get each new listing in its proper alphabetic position.  Enter listings in any order, anywhere in the file.  When finished, save and close the file.  Then use Sort to put the listings in proper order.


You don’t have to sort the address list before copying an address to a letter or envelope.  It makes no difference to the Copy and Print Envelope commands whether the list is sorted or unsorted.  But a sorted list is easier to work with when you’re browsing.





More about Junk Closet


The Junk Closet command is used for storage of text you want to remove from the active file but keep available for possible use later.


To store a block of text in the junk closet, first select the text.  Then run Junk Closet and choose Store Selection.  The text is sent to a file called junk.fmj.  The file was placed in the main Word directory when you installed File Manager Jr.


To find text in the junk file, run the Junk Closet command and choose the Open Closet button.  A Find dialog box appears.  Type a word or phrase peculiar to the block of text you’re looking for.  Then press Enter.  If the junk file is small and you don’t need to run a search, press Esc to close the Find box.


To retrieve a block of text from the junk file, first select the text and place it on the Windows Clipboard.  Then close the junk file and copy the text from the Clipboard to the active file.


When you open the junk file, text in that file is displayed in whatever style you’re using in the active document.  Result: You won’t need to apply your current style to text imported from the junk closet.  The style will already have been applied.


A separator mark appears before each block of text stored in the junk file so that you can easily tell where one block ends and the next begins.  The name of the file from which the block was extracted appears below the separator mark, along with the date and time the block was placed in the junk file.


To delete text from the junk file, first execute Junk Closet and choose Open Closet.  Select the text you want to erase and press the Delete key.  Then choose Close on the File menu and answer Yes when asked whether to save changes.





Input boxes


An input box is a dialog box in which you type information.  File Manager Jr. uses many such boxes.  It may display an input box, for example, so that you can type a filename or directory name.  When finished typing, you can choose the OK button by clicking it or by pressing Tab and then Enter.  If you press Enter without first pressing Tab, the cursor moves down a line and becomes improperly positioned.  If you then try to choose OK by pressing Tab and Enter, an error message appears.  Tip:  If you press Enter prematurely, use the Backspace key to position the cursor just after the last character you typed.  Then press Tab and Enter.





Assigning Assigning File Manager Jr. to a shortcut key


On the Tools menu, choose Customize.


In the Customize dialog box, click the Keyboard tab (at the upper right).   


In the Categories list box, click Macros.


In the Macros list box (to the right of Categories), click FileMgrJr.


Click the box labeled Press New Shortcut Key.  Press a key or combination of keys.  Example: If you want File Manager Jr. to start when you hold down Ctrl and strike J (for “Junior”), press the Ctrl key and, without releasing it, press J.


Choose Assign.


Choose Close.





Note   When File Manager Jr. is installed, it is assigned to a special shortcut key (Alt+Ctrl+Shift+Backspace).  That key performs an internal function and should be kept in place.  It won’t interfere with your own File Manager Jr. shortcut key.





Assigning File Manager Jr. to a toolbar button


On the Tools menu, choose Customize.


In the Customize dialog box, click the Toolbars tab (at the upper left).


In the Categories list box, click Macros.


In the Macros box (to the right of Categories), click the name FileMgrJr. and keep the left mouse button depressed.  A rectangular outline appears.  Drag the outline to a position on the toolbar and release the mouse button.


In the box labeled Text Button Name, type a short name, such as jr.


Choose Assign.


Choose Close.


Starting File Manager Jr. automatically


If you want the File Manager Jr. menu to appear automatically whenever you start Word, do this:


Start File Manager Jr.


On the main menu, choose the Setup button.


In the Setup box, choose AutoMenu Setup.  Follow the onscreen directions.
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Registration information


File Manager Jr. is a shareware program.  You’re required to register the program if you continue to use it after a 30-day trial period.  You can become a registered user by paying a fee of $15 to the author, Charles Maher, 409 North 18th Street, Coeur d’Alene, Idaho 83814-5460.  If you have a MasterCard or Visa account, you can call toll-free to register.  To register by voice phone, call 1-800-215-3688 between 6 a.m. and 3 p.m. Pacific time.  If you have a modem, you can use a 24-hour number: 1-800-503-2292.  Indicate that you are registering a product developed by vendor 3864.
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